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ഡിിസൈൈന്‍ ഫാാക്ടറിി

സ്കൂൂളിിനടുുത്തുുള്ള ഡിിസൈൈനിങ്് സ്റ്റുുഡിിയോ�ോ ൈന്ദർ

ശിിച്ചതിിനു യോശിഷംം, ടുീച്ചർ ആവശിയപ്പെ�ട്ടതിനുൈരിിച്ച് 

അതിിപ്പെ� വിവരിണംം തിയ്യാോറാോക്കാോൻ തിുടുങ്ങിി�യോ�ോയോ�ക്കാും 

ൈിതിോരി�ും കൂൂട്ടുകൂോരിും ഗ്രാോഫിികൂ് ഡിിസൈൈനിങ്ങിിയോനോടു് 

ഏപ്പെറാ അടുുത്തുുകൂ�ിഞ്ഞിിരിുന്നുു.

അധ്യാ�ായംം 1

ഡിിസൈൈന്‍ ഫാാക്ടറിി 

നിിറങ്ങളിിൽ പൊ�ൊതിിഞ്ഞ ഏതിൊനിം� കൂൂറ്റൻ 

ബോ�ൊർഡുംകൂൾ കൂംറച്ചാൊളിംകൂൾ ചുംമന്ന്് വാൊഹനി

ത്തിിബോ�ക്ക്് കൂയറ്റൊൻ ശ്രമിക്ക്ംകൂയൊണ്്. ചുി� 

ബോ�ൊർഡുംകൂളിിൽ ചുിരിിക്ക്ംന്ന് മംഖങ്ങളിംണ്ട്്, 

ചുി�തിിൽ നൃത്തി� പൊചുയ്യുംന്ന്തിൊയി ബോതിൊന്ന്ംന്ന് 

പൊ�രിംക്ക്മംള്ള വാരികൂൾ. മറ്റംള്ളവായിൽ നിിറപൊയ 

വാൊക്ക്ംകൂൾ മൊത്രം�. വാ�ംതിം� പൊചുറംതിംമൊയ 

ഏതിൊനിം� ബോ�ൊർഡുംകൂൾ മറ്റൊപൊരിബോയൊ കൂൊത്തി് 

അവാിടവാിപൊടയൊയി ചുൊരിിയിരിിപ്പുംമംണ്ട്്.

വാീതിി കൂംറഞ്ഞപൊതിങ്കിി�ം� ഇരിംവാശവാം� 

വാരികൂളിം� എഴുംത്തിംകൂളിം� നിിറഞ്ഞ കൂൊൻവാൊ

സുംകൂൾ തിൂങ്ങിക്ക്ിടക്ക്ംന്ന് നിീളിമംള്ള വാരിൊന്ത

യിബോ�ക്ക്് കൂയറൊൻ തിംടങ്ങംബോ�ൊഴുൊണ്്, മഷിി 

ഇറ്റംവാീഴുംപൊമന്ന്് ബോതിൊന്ന്ിക്ക്ംന്ന് ഒരിം ബ്രഷി് നിിരി

ത്തിിവാച്ചാിരിിക്ക്ംന്ന് പൊ�യിന്റ്് കൂപ്പുംകൂളിിപൊ�ൊന്ന്ിൽ 

വാച്ചാ്, കൈകൂകൂൾ ബോകൂൊട്ടൺ ബോവാസ്റ്റിിൽ തിംടച്ചാ് 

ഒരിൊൾ �ംറബോത്തിക്ക്ം വാന്ന്തി്. ആർട്ടിസ്റ്റി്!! നിമ്മുംപൊട 

�ംതിിയ സ്കൂൂൾ പൊകൂട്ടിടത്തിിനിം മംകൂളിിൽ സ്കൂൂളിി

പൊന്റ് ബോ�രി് ഭം�ഗിിയൊയി എഴുംതിിയതി് ഇബോ�ഹവാം�  

കൂൂട്ടംകൂൊരിം� ബോചുർന്ന്ൊണ്്.

മബോനിൊഹരിമൊയി സു�വാിധാൊനിിച്ചാ ഒരിം വാ�ിയ 

മംറിയിബോ�ക്ക്ൊണ്് അബോ�ഹ� �ങ്ങപൊളി ക്ഷണ്ി

ച്ചാതി്. വാ�ിയ സ്ക്രീീനിംകൂളിംള്ള കൂ�ൂൂട്ടറംകൂളിി�ം� 

ഇതിംവാപൊരി കൂൊണ്ൊത്തി ചുി� പ്രിിന്റ്ിങ്് യന്ത്രങ്ങ

ളിി�ം� കൂംബോറയൊളിംകൂൾ അവാിപൊട  ബോ�ൊ�ിപൊചുയ്തും

പൊകൂൊണ്ട്ിരിിക്ക്ംന്ന്ം.

മംറിയിൽ അക്ഷരിങ്ങളിം� വാരികൂളിം� രിൂ�ങ്ങ

ളിം� നിിറങ്ങളിം� ബോചുർത്തിംവാച്ചാ, സു�സുൊരിിക്ക്ംന്ന് 

പൊ�യിന്റ്ിങ്ങംകൂൾ... അവായിപൊ� ഏറ്റവാം� �ളിി

തിമൊയ വാരി ബോ�ൊ�ം� ആപൊരിപൊയങ്കിി�ം� സുബോന്തൊ

ഷിിപ്പുിക്ക്ൊതിിരിിക്ക്ില്ല.

“ഇവാിപൊടയൊണ്് ഗ്രാൊഫിികൂ് ഡുികൈസുനിിങ്് 

നിടക്ക്ംന്ന്തി്” - അബോ�ഹ� �റഞ്ഞം.
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ഗ്രാാഫിിക്് ഡിിസൈൈനിിങ്്:  

വരക്ളുുടെെയംും നിിറങ്ങളുുടെെയംും ലോ�ാക്ം

ആശി�ങ്ങിളിുപ്പെടു�ും ഉല്‍�ന്നുങ്ങിളിുപ്പെടു�ും പ്രചാോരി

ണംത്തുിനോ�ി  ഉപയോ�ോഗിിക്കാുന്നു  യോപോസ്റ്റുറാുകൂളിും ബാോനറാു

കൂളിും യോബാോർഡിുകൂളിും  കൂണ്ടിിട്ടിയോ�. അവ�ുപ്പെടു ഉള്ളടുക്കാ

വും രിൂപകൂല്‍�ന�ും ശ്രദ്ധിിച്ചിട്ടുയോണ്ടിോ? 

യോപോസ്റ്റുറാുകൂളിും ബാോനറാുകൂളിും നിർമ്മിിക്കാുകൂ എന്നുതി് 

ഒരിു ൈർഗിോത്മകൂപ്രവർത്തുനമാോണം്. നമ്മിുപ്പെടു നോട്ടിൽ നടു

ക്കാുന്നു വിവിധ പരിിപോടുികൂൾക്കാ് എ�ുതിി�ും വരിച്ചും  

യോപോസ്റ്റുറാുകൂളിും ബാോനറാുകൂളിും തിയ്യാോറാോക്കാുന്നു ആർട്ടിസ്റ്റുുകൂ

ളിില്‍ പലരിും  ഗ്രാോഫിികൂ് എഡിിറ്റിിങ്് യോൈോഫ്റ്റുുപ്പെവ�റാുകൂളിുപ്പെടു 

ൈഹാോ�യോത്തുോപ്പെടു�ും  ഈ പ്രവൃത്തുികൂൾ പ്പെചായ്യാോറാുണ്ടി്.

ഗ്രാോഫിികൂ് ഡിിസൈൈനിങ്് യോ�ോലികൂള്‍ പ്പെചായ്യാോൻ ൈഹാോ

�ിക്കാുന്നു യോൈോഫ്റ്റുുപ്പെവ�റാുകൂളിിൽ ചാിലതി് മാുന്‍വർഷംങ്ങി

ളിിൽ നം പരിിചാ�പ്പെ�ട്ടിട്ടുണ്ടിയോ�ോ.  നമ്മിുപ്പെടു സ്കൂൂളിിപ്പെല ലോ

പ് യോടുോപുകൂളിിൽ ലഭ്യയമാോ� �ിമ്പ്്, ക്രിിറ്റി, ഇങ്ക്്യോസ്കൂപ്, ൈ് സൈക്രി 

ബാൈ്, ലിബാർഓഫിീൈ് യോ�ോ തിുടുങ്ങിി� ൈവതിന്ത്ര യോൈോഫ്റ്റുു

പ്പെവ�ർ ആപ്ലിിയോക്കാഷംനുകൂൾ ഗ്രാോഫിികൂ് എഡിിറ്റിിങ്് യോ�ോലി 

കൂൾക്കാ് ഉപയോ�ോഗിിക്കാോൻ കൂ�ി�ുന്നുവ�ോണം്. ഇവ�ിൽ 

പ്പെവക്ടർ ഗ്രാോഫിികൂ് എഡിിറ്റിിങ്് യോൈോഫ്റ്റുുപ്പെവ�ർ വിഭ്യോഗിത്തുിൽ 

പ്പെപട്ടവ�ോണം് ഇങ്ക്്യോസ്കൂപ്, ലിബാർഓഫിീൈ് യോ�ോ തിുടുങ്ങിി

�വ. ഇവ ഉപയോ�ോഗിിച്ച് നിർമ്മിിക്കാുന്നു ഉല്‍�ന്നുങ്ങിള്‍ക്കാ് 

നിരിവധി ഗിുണംങ്ങിളിുണ്ടി്.

ഉന്നുതിനിലവോരിമാുള്ള പ്പെവക്ടർ ഡിിസൈൈൻ യോ�ോലി 

കൂൾക്കാ് ആർട്ടിസ്റ്റുുകൂളിും പ്പെവബാ് പ്പെഡിവല�ർമാോരിും ഒരിു 

യോപോപ്പെല ഉപയോ�ോഗിപ്പെ�ടുുത്തുുന്നു ഒരിു ൈവതിന്ത്ര ഗ്രാോഫിികൂ് 

എഡിിറ്റിിങ്് യോൈോഫ്റ്റുുപ്പെവ�റാോണം് ഇങ്ക്്യോസ്കൂപ്. ഹാിയോരിോഷംിമാ 

ദിിനോചാരിണംവുമാോ�ി ബാന്ധപ്പെ�ട്ട ഒരിു ഡിി�ിറ്റിൽ യോപോസ്റ്റുർ 

ഇങ്ക്്യോസ്കൂപ് യോൈോഫ്റ്റുുപ്പെവ�ർ ഉപയോ�ോഗിിച്ച് നിർമ്മിിച്ചോയോലോ.

യോനോട്ടീൈുകൂൾ, ചാുമാർപത്രിികൂകൂൾ, യോപോസ്റ്റുറാുകൂൾ 

എന്നുിവപ്പെ��ം നിങ്ങിൾ തിയ്യാോറാോക്കാി�ിട്ടുണ്ടിയോ�ോ. കൂമ്പ്യൂ

ട്ടറാിൽ ഒരിു  യോപോസ്റ്റുര്‍ നിര്‍മ്മിിക്കാുന്നുതിിപ്പെ� ഘട്ടങ്ങിള്‍ 

എപ്പെ�ോപ്പെക്കാ�ോണം്?

 � ആവശിയമാനുൈരിിച്ചുള്ള  കൂോൻവോൈ്  നിര്‍മ്മിോണംം.

 � യോപോസ്റ്റുറാിപ്പെ� ൈയോന്ദശിം ഫിലപ്രദിമാോ�ി വിനിമാ�ം 

പ്പെചായ്യാോൻ ൈഹാോ�ിക്കാുന്നു പ്പെടുകൂ്സ്റ്റു് യോ�ോ�യമാോ� രിീതിി 

�ില്‍ ഉള്‍പ്പെ�ടുുത്തുല്‍.

 � യോപോസ്റ്റുര്‍ ആകൂര്‍ഷംകൂമാോക്കാുന്നുതിിനോവശിയമാോ� വരികൂൾ, 

ചാിത്രിങ്ങിൾ, രിൂപങ്ങിൾ എന്നുിവ�ുപ്പെടു ക്രിമാീകൂരിണംം.

ഇങ്ക്്ലോ�പ്് എന്ന  

ഡിിസൈൈൻ ഫിാക്് െറി

ഒരിു ൈവതിന്ത്ര പ്പെവക്ടര്‍ ഗ്രാോഫിികൂ് 

ഡിിസൈൈനിങ്് യോൈോഫ്റ്റുുപ്പെവ�റാോണം് 

ഇങ്ക്് യോസ്കൂപ്. യോലോയോഗിോകൂൾ, ചാിത്രിീകൂ

രിണംങ്ങിൾ, യോപോസ്റ്റുറാുകൂൾ, യോ�ോഷം

റാുകൂൾ, സൈടുയോ�ോഗ്രാോഫിി എന്നുിവ 

കൃതിയതിയോ�ോപ്പെടു�ും ൈർഗിോത്മകൂതി

യോ�ോപ്പെടു�ും രിൂപകൂൽ�ന പ്പെചായ്യാോൻ 

ഇങ്ക്്യോസ്കൂപ് വയോപകൂമാോ�ി ഉപയോ�ോ

ഗിിച്ചുവരിുന്നുു. വരി, രിൂപങ്ങിളിുപ്പെടു നിർ

മ്മിോണംം,  എഡിിറ്റിിങ്് എന്നുിവയ്ക്കാോ�ി 

എളിു�ത്തുിൽ ഉപയോ�ോഗിിക്കാോവുന്നു 

നിരിവധി ടുൂളിുകൂൾ ഈ യോൈോഫ്റ്റുുപ്പെവ

പ്പെ�റാിലുണ്ടി്. 

ഇങ്ക്് യോസ്കൂ�ിപ്പെ� തിനതിു ഫി�ൽ യോഫിോർ

മാോറ്റി് പ്പെസ്കൂ�ിലബാിൾ പ്പെവക്ടർ ഗ്രാോഫിി

കൂ് ൈ് (SVG) ആണം്. SVG, AI, EPS, 
PDF, PS, PNG എന്നുീ ഫി�ല്‍ യോഫിോര്‍മാോ

റ്റിുകൂള്‍ ഇങ്ക്്യോസ്കൂപ് പി�ുണംയ്ക്കാുന്നുു.
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 � ............................................................................................................

 � ............................................................................................................

 � ............................................................................................................

യോവറാിട്ടുനിൽക്കാുന്നുതിും കൂോ�്ചാക്കാോപ്പെരി ആകൂർഷംിക്കാു

ന്നുതിുമാോ� ഒരിു ഡിിസൈൈൻ സൃഷം് ടുിക്കാോനോ�ി ഈ ഘടു

കൂങ്ങിൾ യോപോസ്റ്റുറാില്‍ ൈംയോ�ോ�ി�ിക്കാുന്നുപ്പെതിങ്ങിപ്പെനപ്പെ�ന്നുു  

യോനോക്കാം.

യോപോസ്റ്റുര്‍ തിയ്യാോറാോക്കാുന്നുതിിനോ�ി നിങ്ങിളിുപ്പെടു കൂമ്പ്യൂ

ട്ടറാിൽ ഇങ്ക്്യോസ്കൂപ് യോൈോഫ്റ്റുുപ്പെവ�ർ തിുറാക്കാൂ. ഇയോ�ോള്‍  

തിുറാന്നുുവന്നു �ോലകൂം പരിിചാ�പ്പെ�ടും. (ചാിത്രിം 1.1)

�ോലകൂത്തുില്‍ ഇടുതിുഭ്യോഗിത്തു് ഇങ്ക്്യോസ്കൂ�ിപ്പെല 

ടുൂളിുകൂളിും ചാുവപ്പെടു കൂളിര്‍പോലറ്റിും കൂോണംം. ടുൂളിുകൂളിില്‍ 

ഓയോരിോന്നുിലും മാ�ൈ് പ്പെകൂോണ്ടിുയോപോ�ി വച്ച് അവ�ുപ്പെടു 

യോപരിുകൂൾ ശ്രദ്ധിിക്കാുമായോ�ോ.

ചിിത്രംം 1.1 ഇങ്ക്്ലോ�പ്് ജാാ�ക്ം

ഇനി നമാുക്കാ് യോപോസ്റ്റുര്‍ നിര്‍മ്മിിച്ചു തിുടുങ്ങിം.

ആദിയമാോ�ി ഒരിു കൂോന്‍വോൈ് തിയ്യാോറാോക്കാുകൂ�ോണം് 

യോവണ്ടിതി്.
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ക്ാൻവാൈ് തയ്യാാറാക്കാംം

ചാുമാരിുപ്പെണ്ടിങ്ക്ിയോല ചാിത്രിപ്പെമാ�ുതിോനോകൂൂ എന്നു് യോകൂട്ടി 

ട്ടിയോ�. അതിുയോപോപ്പെല യോപോസ്റ്റുറാിപ്പെല ആശി�ങ്ങിള്‍ക്കാ്  

വളിരിോനും വികൂൈിക്കാോനുമാുള്ള അടുിത്തുറാ�ോണം് കൂോൻവോൈ്.  

ഡിിസൈൈനുകൂളിുപ്പെടു ആവശിയങ്ങിൾക്കാനുൈരിിച്ചുള്ള യോപ�് 

വലു�ം ഇങ്ക്്യോസ്കൂ�ിൽ തിിരിപ്പെഞ്ഞിടുുക്കാോൻ കൂ�ി�ും.  

യോപോസ്റ്റുര്‍നിർമ്മിോണംത്തുിപ്പെ� ഏതിു ഘട്ടത്തുിലും യോപ�് 

വലു�ം, �ൂണംിറ്റിുകൂൾ, ഓറാി�യോ�ഷംൻ എന്നുിവ ആവശിയ

പ്പെമാങ്ക്ില്‍ മാോറ്റിി ക്രിമാീകൂരിിക്കാോനും കൂ�ി�ും.

യോപ�ിനു പുറാത്തുുള്ള ഒ�ിഞ്ഞി ഭ്യോഗിം കൂൂടുി ഉൾപ്പെ�

ട്ടതിോണം് ഇങ്ക്്യോസ്കൂ�ിപ്പെ� വർക്കാ്യോ�ൈ്. ഡിിസൈൈൻ ഘടുകൂ

ങ്ങിള്‍ തിയ്യാോറാോക്കാോന്‍ ഈ യോമാഖല�ും ഉപയോ�ോഗിിക്കാം.

300 mm x 350 mm വലു�ത്തുിലുള്ള ഒരിു യോപോസ്റ്റു

റാോണം് നം നിര്‍മ്മിിക്കാുന്നുതി്. ഇങ്ക്്യോസ്കൂ�ിപ്പെല Document 
Properties �ോലകൂം തിുറാന്നു്,  യോപ�ിപ്പെ� വലു�ം നമ്മിുപ്പെടു 

യോപോസ്റ്റുറാിന് യോ�ോ�ിച്ച രിീതിി�ിൽ  ക്രിമാീകൂരിിക്കാൂ.
ടെവക്ടർ ചിിത്രംങ്ങളുും 

റാസ്റ്റർ ചിിത്രംങ്ങളുും 

നിങ്ങിൾ മാുൻക്ലാോൈുകൂളിിൽ പരിി

ചാ�പ്പെ�ട്ട �ിമ്പ്്, ക്രിിറ്റി എന്നുിവ  

റാോസ്റ്റുർ ഇയോമാ�് എഡിിറ്റിിങ്് യോൈോഫ്റ്റുു

പ്പെവ�റാുകൂളിോണം്. റാോസ്റ്റുർ ഇയോമാ�ുകൂൾ  

പികൂ്ൈലുകൂളിോൽ നിർമ്മിിതിമാോ�തിി

നോൽ, അവ പ്പെസ്കൂ�ിൽ പ്പെചായ്യാുയോമ്പ്ോൾ  

പികൂ്ൈയോലറ്റി് ആകൂുകൂയോ�ോ ഗിുണംനി

ലവോരിം നഷ്ടപ്പെ�ടുുകൂയോ�ോ പ്പെചായ്യാുന്നുു. 

JPEG, PNG എന്നുിവ റാോസ്റ്റുർ ഫി�ല്‍ 

യോഫിോര്‍മാോറ്റിുകൂൾക്കാ് ഉദിോഹാരിണംങ്ങി 

ളിോണം്.

ഗിുണംനിലവോരിം നഷ്ടപ്പെ�ടുോപ്പെതി 

വലു�ം മാോറ്റിോൻ കൂ�ി�ുന്നുവ 

�ോണം് പ്പെവക്ടർ ചാിത്രിങ്ങിൾ.  ഗിണംിതി

ൈമാവോകൂയങ്ങിൾ അടുിസ്ഥാോനമാോക്കാി 

�ോണം് ഇവ�ിപ്പെല വരികൂളിും രിൂപങ്ങി

ളിും നിര്‍മ്മിിക്കാപ്പെ�ടുുന്നുതി്. പ്പെസ്കൂ�ിൽ 

പ്പെചായ്യാോനുള്ള ൈ�കൂരിയം, എഡിിറ്റി്  

പ്പെചായ്യാോനുള്ള എളിു�ം, കൂുറാഞ്ഞി ഫി�ൽ 

സൈൈൈ് എന്നുിവ�ോണം് ഇവ�ുപ്പെടു 

പ്രയോതിയകൂതികൂൾ. SVG, EPS എന്നുിവ 

പ്പെവക്ടർ ഫി�ൽ യോഫിോർമാോറ്റിുകൂളിോണം്.

ചിിത്രംം 1.2 ടെവക്ടറും റാസ്റ്ററും

ചിിത്രംം 1.3 Document Properties ജാാ�ക്ം

ലോപ്ജാിടെ� വ�ുപ്പംം ക്രമീീക്രിക്കാംുന്നതിനി് 

 � File → Document Properties എന്നു ക്രിമാത്തുിൽ തിുറാ

ക്കാുകൂ. (Shift + Ctrl + D എന്നു യോഷംോർട്ട് കൂട്ട് കൂീ�ും 

ഉപയോ�ോഗിിക്കാം).

 � തിുറാന്നുുവരിുന്നു �ോലകൂത്തുില്‍ നിലവിലുള്ള ഒരിു Page 
Size തിിരിപ്പെഞ്ഞിടുുക്കാുകൂയോ�ോ ഉചാിതിമാോ� �ൂണംിറ്റിി 

ലുള്ള വീതിി�ും ഉ�രിവും സൈടു�് പ്പെചായ്ത്് യോപ�് നിർ

മ്മിിക്കാുകൂയോ�ോ പ്പെചായ്യാം.

 � യോപ�ിപ്പെ� ഓറാി�യോ�ഷംനും ഇവിപ്പെടു തിിരിപ്പെഞ്ഞിടുുക്കാം. 

(ചാിത്രിം 1.3)
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വരയ്ക്കാംം, എഴുുതം, െൂളുുക്ൾ പ്രിചിയംടെപ്പംെം

ലളിിതിവും ൈങ്ക്ീർണ്ണവുമാോ� ഗ്രാോഫിികൂ് ഡിിസൈൈനിങ്് 

പ്രവർത്തുനങ്ങിൾ പ്പെചായ്യാുന്നുതിിനുള്ള ടുൂളിുകൂൾ ഇങ്ക്്യോസ്കൂ

�ിൽ ലഭ്യയമാോണം്. കൂോൻവോൈിപ്പെ� ഇടുതിുവശിപ്പെത്തു ടുൂൾ

ബാോറാിൽനിന്നു് ടുൂളിുകൂൾ പ്പെൈലക്ട് പ്പെചായ്ത്് വർക്കാ് യോ�ൈില്‍, 

വിവിധ രിൂപങ്ങിൾ വരിച്ച് അവ�ുപ്പെടു ഉപയോ�ോഗിം പരിിയോശിോ

ധിക്കാൂ. യോശിഷംം പട്ടികൂ 1.1 പൂർത്തുി�ോക്കാുമായോ�ോ.

ഇങ്ക്്ലോ�പ്പംിടെ� െൂളുുക്ൾ

 � ടുൂൾബാോറാില്‍നിന്നു് Create rectangles & squares (R) എടുുത്തു് ചാതിുരിം  

വരിയ്ക്കാം.

 � ഈ ചാതിുരിത്തുിൽ രിണ്ടിോമാതിും ക്ലാിക്കാ് പ്പെചായ്ത്ോൽ, പ്പെചാറാുതിോ�ി തിിരിിക്കാോനും 

അതിിപ്പെന ഒരിു ൈോമാോ�രിികൂമാോക്കാി മാോറ്റിോനും ൈോധിക്കാും (ചാിത്രിം 1.4).
 � Select and transform objects (S) ടുൂൾ ഉപയോ�ോഗിിച്ച് ഒബാ്�ക്ടുകൂള്‍  പ്പെൈലക്ട് 

പ്പെചായ്യാം. അവ�ുപ്പെടു വലു�ത്തുിൽ വയതിയോൈം വരിുത്തും.

 � Ctrl കൂീ അമാര്‍ത്തുിപ്പെക്കാോണ്ടി് വലു�വയതിയോൈം വരിുത്തുുയോമ്പ്ോൾ ഒബാ്�ക്ടി

പ്പെ� നീളിവും വീതിി�ും ആനുപോതിികൂമാോ�ി വയതിയോൈപ്പെ�ടുും.

 � കൂളിർപോലറ്റിിൽ ക്ലാിക്കാ് പ്പെചായ്ത്് Fill Colour തിിരിപ്പെഞ്ഞിടുുത്തു് ഒബാ്�ക്ടുകൂൾക്കാ് നിറാം നൽകൂം. 

Shift അമാർത്തുിപ്പെക്കാോണ്ടി് നിറാം പ്പെൈലക്ട് പ്പെചായ്ത്ോൽ ഒബാ്�ക്ടിപ്പെ� യോബാോര്‍ഡിറാിന് (Stroke) നിറാം 

യോചാർക്കാം.

 � ടുൂൾബാോറാിൽനിന്നു് Create & edit text objects (T) ടുൂൾ എടുുത്തു്  പ്പെടുകൂ്സ്റ്റു് സൈടു�് പ്പെചായ്ത്്    യോഫിോർ

മാോറ്റിിങ്് നടുത്തും (പ്പെടുകൂ്സ്റ്റു് പ്പെൈലക്ട് പ്പെചായ്യാുയോമ്പ്ോൾ  �ോലകൂത്തുിനു മാുകൂളിിലുള്ള Tools Controls 
barല്‍ പ്പെടുകൂ്സ്റ്റു് യോഫിോർമാോറ്റിിങ്് ൈയോങ്ക്തിങ്ങിൾ പ്രതിയക്ഷപ്പെ�ടുുന്നുു - ചാിത്രിം 1.5).

ചിിത്രംം 1.5 ടെെക്്സ്റ്റ് ലോഫിാര്‍മീാറ്റ്് ൈലോങ്ക്തങ്ങള്‍

െൂള്‍ ഉപ്ലോയംാഗംം

Create circles, ellipses, and arcs (E) വൃത്തും വരിയ്ക്കാുന്നുതിിന്

Draw Bezier curves and straight lines (B)

Draw free hand lines (P)

Edit Path by nodes (N)

Create and edit Gradients (G)

പ്ട്ടിിക് 1.1 ഇങ്ക്്ലോ�പ്പംിടെ� ചിി� െൂളുുക്ളുും അവയംുടെെ ഉപ്ലോയംാഗംവും

ചിിത്രംം 1.4  
ഒബ്്ജാക്ടില്‍ രണ്ടാാമീതും 

ക്ലിിക്കാം് ടെചിയ്തലോപ്പംാള്‍



ഡിിസൈൈന്‍ ഫാാക്ടറിി

വിിവിരവിിനിിമയ ൈാങ്കേ�തിികവിിദ്യയ-10 12

നിിറം ഒഴുിവാക്കാംാൻ

ഒബാ്�ക്ടുകൂൾക്കാ് നൽകൂി� നിറാം ഒ�ിവോക്കാോൻ കൂളിർ  

പോലറ്റിിപ്പെ�  ഇടുയോത്തു അറ്റിത്തുുള്ള X ഉപയോ�ോഗിിച്ചോൽ 

മാതിി. Shift അമാർത്തുിപ്പെക്കാോണ്ടി് ഈ പ്രവർത്തുനം 

പ്പെചായ്ത്ോൽ ൈ്യോ�ോക്കാിപ്പെ� നിറാം ഒ�ിവോക്കാം.

ലോപ്ാസ്റ്ററിടെനിാരു പ്ശ്ചാാത്ത�ം

യോപോസ്റ്റുറാിന് �ീവൻ നൽകൂുന്നു അ�രിീക്ഷമാോണം് 

അതിിപ്പെ� പശ്ചാോത്തുലം. ഉല്‍�ന്നുത്തുിപ്പെ� പ്പെമാോത്തുത്തുി 

ലുള്ള ആകൂർഷംണംം, ഫിലപ്രോപ്തിി എന്നുിവ�ിൽ അതിിപ്പെ� 

പശ്ചാോത്തുലത്തുിന് വലി� പ്രോധോനയമാോണംുള്ളതി്. 

യോപോസ്റ്റുറാിൽ പിന്നുീടു് യോചാർക്കാോനുള്ള ഉള്ളടുക്കാഘടുകൂ

ങ്ങിളിുപ്പെടു ൈവഭ്യോവമാനുൈരിിച്ച്  പശ്ചാോത്തുലനിറാം തിീരിുമാോനി

ക്കാോവുന്നുതിോണം്. നമ്മിുപ്പെടു യോപോസ്റ്റുറാിന് ഒരിു പശ്ചാോത്തുലം 

നിര്‍മ്മിിക്കാുന്നുപ്പെതിങ്ങിപ്പെനപ്പെ�ന്നുു യോനോക്കാം.

പശ്ചാോത്തുലത്തുിൽ ഒപ്പെരിോറ്റി നിറാം (Solid Colour), 
ഒന്നുിലധികൂം നിറാങ്ങിള്‍ ല�ി�ിച്ചതി് (Gradient Colour), 
ചാിത്രിം തിുടുങ്ങിി�വ പ്രയോതിയകൂമാോയോ�ോ പരി�രിം കൂൂട്ടിയോച്ചർ

യോത്തുോ ഉപയോ�ോഗിിക്കാം. നമ്മിുപ്പെടു  യോപോസ്റ്റുറാിന് ഒരിു Solid 
Colour പശ്ചാോത്തുലം പ്പെകൂോടുുക്കാുന്നുതിിനോ�ി തിോപ്പെ� പ്പെകൂോടുു

ത്തുിട്ടുള്ള പ്രവര്‍ത്തുനങ്ങിള്‍ പ്പെചായ്ത്ുയോനോക്കാൂ.

ചിിത്രംം 1.6 ലോപ്ാസ്റ്ററിനി് പ്ശ്ചാാത്ത�ം വരച്ചലോപ്പംാള്‍
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ലോപ്ാസ്റ്ററിനി് പ്ശ്ചാാത്ത�ം നിിർമ്മിിക്കാംുന്നതിനി്

 � ടുൂൾബാോറാിൽനിന്നു് Create rectangles & squares (R) 
ടുൂൾ എടുുത്തു് യോപ�ിൽ ചാിത്രിം 1.6ൽ നൽകൂി�തിു

യോപോപ്പെല ഒരിു ചാതിുരിം വരിയ്ക്കാുകൂ.

 � ചാതിുരിത്തുിപ്പെ� വലു�ം കൃതിയമാോ�ി ക്രിമാീകൂരിിക്കാോൻ 

Select Tool ഉപയോ�ോഗിിച്ച് ചാതിുരിം പ്പെൈലക്ട് പ്പെചായ്ത് 

യോശിഷംം, Tools Controls bar ൽ Width & Height (മാുമ്പ്് 

യോപ�ിന് പ്പെകൂോടുുത്തു അയോതി വിലകൂൾ) സൈടു�് പ്പെചായ്ത്് 

പ്പെകൂോടുുക്കാുകൂ.

 � ഈ ചാതിുരിപ്പെത്തു യോപ�ിൽ കൃതിയമാോ�ി ക്രിമാീകൂരിിക്കാുന്നു

തിിനോ�ി യോഫിോർമാോറ്റിിങ്് ടുൂൾബാോറാിൽ X, Y വിലകൂൾ 0 
(പൂ�യം) പ്പെകൂോടുുക്കാുകൂ.

 � തിോപ്പെ��ുള്ള കൂളിർപോലറ്റിിൽനിന്നു് അനുയോ�ോ�യമാോ� 

ഒരിു നിറാം പ്പെൈലക്ട് പ്പെചായ്യാുകൂ (ഇയോ�ോൾ തിിരിഞ്ഞിടുുത്തു 

നിറാം പിന്നുീടു് ആവശിയപ്പെമാങ്ക്ിൽ മാോറ്റിോവുന്നുതിോണം്).

ഉച്ചത്തി�ും വ�ക്തമീായംും ൈംൈാരിക്കാംുക്

ഒരിു യോപോസ്റ്റുറാിപ്പെ� ആശി�ം ഫിലപ്രദിമാോ�ി വിനിമാ�ം 

പ്പെചായ്യാോൻ ൈഹാോ�ിക്കാുന്നു പ്രധോന ഘടുകൂമാോണം് അതിിൽ 

ഉൾപ്പെ�ടുുത്തുുന്നു ൈയോന്ദശിം.  അക്ഷരിങ്ങിളിുപ്പെടു സൈസ്റ്റുൽ, 

വലു�ം, നിറാം, ഉചാിതിമാോ� വിനയോൈം എന്നുിവ ആകൂർ

ഷംകൂമാോ� രിീതിി�ിലോ�ിരിിക്കാണംം യോപോസ്റ്റുറാില്‍ ഉള്‍യോച്ച

ര്‍യോക്കാണ്ടിതി്. ചാുരിുങ്ങിി� വോക്കാുകൂൾ ഉപയോ�ോഗിിച്ച് ഏറ്റിവും 

ശിക്തമാോ� വിധത്തുില്‍ ആശി�പ്പെമാത്തുിക്കാോൻ ഡിിസൈൈനർ

മാോർ ശ്രദ്ധിിക്കാോറാുണ്ടി്.

ഹാിയോരിോഷംിമാദിിനോചാരിണംവുമാോ�ി ബാന്ധപ്പെ�ട്ട യോപോ

സ്റ്റുറാോണംയോ�ോ നോമാിവിപ്പെടു തിയ്യാോറാോക്കാുന്നുതി്. യോപോസ്റ്റുറാിലൂ

പ്പെടു ൈമാൂഹാത്തുിന് നൽകൂോനുള്ള ൈയോന്ദശിം എ�ോ�ി

രിിക്കാണംം,  അതിിപ്പെ� രിൂപകൂല്‍�ന എങ്ങിപ്പെന�ോവണംം 

എപ്പെന്നു�ം തിീരിുമാോനിച്ചിട്ടോവണംം യോപോസ്റ്റുര്‍ നിര്‍മ്മിോണം

ത്തുിയോലക്കാ് കൂടുക്കാോന്‍. പ്പെടുകൂ്സ്റ്റു് ടുൂൾ ഉപയോ�ോഗിിച്ച് നിങ്ങി

ളിുപ്പെടു യോപോസ്റ്റുറാിൽ ചാിത്രിം 1.7 യോലതിുയോപോപ്പെല �ുദ്ധിവിരിുദ്ധി 

ൈയോന്ദശിം ഉൾപ്പെ�ടുുത്തുൂ.

ഫി�ല്‍  

യോൈവ് പ്പെചായ്യാോന്‍  

മാറാന്നുി�യോ�ോ.
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ചിിത്രംം 1.7 ടെെക്സ്്റ്റ് ലോഫിാര്‍മീാറ്റ്ിങ്്

ലോപ്ാസ്റ്ററില്‍ ടെെക്്സ്റ്റ് ഉള്‍ടെപ്പംെുത്തുന്നതിനി്

 � Create and edit text objects (T) ടുൂൾ ഉപയോ�ോഗിി

ച്ച് പശ്ചാോത്തുലത്തുിൽ പ്പെടുകൂ്സ്റ്റു് സൈടു�് പ്പെചായ്ത്് യോചാർ

ക്കാുകൂ. (ഉദിോഹാരിണംം: SAY NO TO WAR, AUG 06, 
HIROSHIMA DAY)

 � വയതിയസ്ത യോഫിോർമാോറ്റിിങ്് ആവശിയമാുള്ള വോക്കാുകൂൾ  

പ്രയോതിയകൂ പ്പെടുകൂ്സ്റ്റു്യോബാോകൂ്ൈുകൂളിിൽ സൈടു�് പ്പെചായ്യാുന്നു

തിോണം് ന�തി്.

 � പ്പെടുകൂ്സ്റ്റു് ആകൂർഷംകൂമാോക്കാുന്നുതിിനോ�ി  Font Type, 
Size, Colour, Position എന്നുിവ തിിരിപ്പെഞ്ഞിടുുക്കാുകൂ 

(ഇവിപ്പെടു Font: Ubuntu Condensed, Size: 125 pt, Stroke 
Line Width: 2.5 mm എന്നുിങ്ങിപ്പെന നൽകൂി�ിരിിക്കാുന്നുു).

 � Stroke ക്രിമാീകൂരിണംങ്ങിൾ ലഭ്യിക്കാോനോ�ി Object 

പ്പെമാനുവിപ്പെല Fill and Stroke എടുുക്കാം.

സൈടു�് പ്പെചായ്ത് ൈയോന്ദശിം ചാിത്രിം 1.7 ല്‍ കൂോണംുന്നു 

തിരിത്തുിൽ പശ്ചാോത്തുലത്തുിൽ ക്രിമാീകൂരിിച്ചുയോനോക്കാൂ.  

പ്പെടുകൂ്സ്റ്റുുകൂൾക്കാ് അനുൈരിിച്ച് പശ്ചാോത്തുലനിറാത്തുിലും 

മാോറ്റിം വരിുത്തുയോണം.

ലോപ്ാസ്റ്ററിടെ� ൈലോ�ശംം

ചാരിിത്രിത്തുിൽ ൈമാോനതികൂളിി�ോത്തു  

മാനുഷംയതിവവിരിുദ്ധി പ്രവൃത്തുി�ോണം്  

ഹാിയോരിോഷംിമാ�ിലും നോഗിൈോക്കാി�ി

ലും ഉണ്ടിോ�തി് എന്നു് നമാുക്കാറാി�ം. 

�ുദ്ധിപ്പെവറാിപ്പെക്കാതിിരിോ� ൈയോന്ദശിമായോ� 

ഈ യോപോസ്റ്റുറാിൽ ഉണ്ടിോയോകൂണ്ടിതി്.
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ചിിത്രംങ്ങളുുടെെ രൂപ്ക്ല്‍പ്പംനിയംും എഡിിറ്റ്ിങ്ങും

ആശി�പ്പെത്തു പ്രതിിനിധീകൂരിിക്കാുന്നു ഒരിു ചാിത്രിയോമാോ 

രിൂപയോമാോ യോപോസ്റ്റുറാില്‍ ഉൾപ്പെ�ടുുത്തുുന്നുതി് അതിിപ്പെന കൂോ�്ചാ

ക്കാോരിുമാോ�ി   എളിു�ത്തുിൽ ൈംവദിിക്കാോൻ ൈഹാോ�ിക്കാും. 

ലളിിതിമാോ� ചാിത്രിങ്ങിൾ വരിയ്ക്കാുന്നുതിിനും യോഫിോയോട്ടോകൂൾ ഉൾ

പ്പെ�ടുുത്തുി അതിിൽ ആവശിയമാോ� എഡിിറ്റിിങ്് നടുത്തുുന്നുതിി

നും ഇങ്ക്്യോസ്കൂ�ിൽ ൈ�കൂരിയമാുണ്ടി്.

ഹാിയോരിോഷംിമാദിിനത്തുിപ്പെ� ൈയോന്ദശിം �ുദ്ധിവിരിുദ്ധിതി

�ുയോടുതിോണംയോ�ോ. പ്പെവളിുത്തു നിറാവും ഒലീവിലകൂളിും പ്രോവു

പ്പെമാ�ം ൈമാോധോനത്തുിപ്പെ� ചാിഹ്നങ്ങിളിോ�ി ഉപയോ�ോഗിിക്കാോ

റാുണ്ടി്.

ഒലീവില�ുമാോ�ി പറാക്കാുന്നു ഒരിു പ്രോവിപ്പെ� ചാിത്രിം 

യോപോസ്റ്റുറാിൽ ഉൾപ്പെ�ടുുത്തുി�ോൽ ഈ ആശി�ം കൂൂടുുതിൽ 

വയക്തമാോകൂിയോ�. നമാുക്കാ് ശ്രമാിച്ചുയോനോക്കാി�ോയോലോ.

ഇങ്ക്്യോസ്കൂ�ിൽ തിയ്യാോറാോക്കാി�  പ്രോവിപ്പെ� ഒരിു യോരിഖോ 

ചാിത്രിം (dove.svg) School_Resources യോഫിോൾഡിറാിലുണ്ടി്.

ഈ ഫി�ൽ File → Open വ�ി ഇങ്ക്്യോസ്കൂ�ിൽ തിുറാന്നു് 

ചാിത്രിം യോകൂോ�ി പ്പെചായ്ത്് കൂോൻവോൈിൽ യോപസ്റ്റു് പ്പെചായ്യാൂ. (ചാിത്രിം 

1.8)

ചിിത്രംം 1.8 ഇങ്ക്്ലോ�പ്പംില്‍ വരച്ച പ്രാാവിടെ� ചിിത്രംം

Bezier Curve ടുൂൾ ഉപയോ�ോഗിിച്ചോണം് പ്രോവിപ്പെ� യോരിഖോ 

ചാിത്രിം വരിച്ചിരിിക്കാുന്നുതി്. ഇങ്ക്്യോസ്കൂ�ിൽ വരികൂളിും ൈംവൃതി 

രിൂപങ്ങിളിും വരിയ്ക്കാോൻ ഉപയോ�ോഗിിക്കാുന്നു ടുൂളിോണം് Draw 
Bezier curves and straight lines (B) ടുൂൾ.

Bezier curve Tool

ഇങ്ക്്യോസ്കൂ�ിപ്പെല പ്രധോനപ്പെ�ട്ട ഒരിു 

ടുൂളിോണം് Draw Bezier curves and 
straight lines ടുൂൾ (Pen Tool) ഈ 

യോപരി് രിൂപപ്പെമാടുുക്കാുന്നുതി് ഫ്രഞ്ച്് 

എൻ�ിനീ�റാോ�ിരിുന്നു Pierre Bezier 
(1910–1999) പ്പെ� യോപരിിൽനിന്നുോണം്.

Node കൂളിും Handle കൂളിും ഉപയോ�ോ 

ഗിിച്ച് സൈകൂകൂോരിയം പ്പെചായ്യാോൻ കൂ�ി�ുന്നു  

യോനർയോരിഖകൂളിും Curveകൂളിും വരി

യ്ക്കാോൻ ഇതി്  ഉപയോ�ോഗിിക്കാുന്നുു,

ൈങ്ക്ീർണ്ണമാോ� രിൂപങ്ങിൾ, യോലോയോഗിോ 

കൂൾ, ചാിത്രിീകൂരിണംങ്ങിൾ, യോഫിോണ്ടിു 

കൂൾ എന്നുിവ രിൂപകൂൽ�ന 

പ്പെചായ്യാോൻ Bezier curve Tool ഉപയോ�ോ

ഗിിച്ച് ൈോധിക്കാു ം.
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ഒ�ീവി�ക്ൾ വരയ്ക്കാംുന്നതിനി്

 � Create circles, ellipses and arcs (E) ടുൂൾ ഉപയോ�ോഗിിച്ച് 

ഒരിു പ്പെചാറാി� വൃത്തും വരിയ്ക്കാുകൂ.

 � അതിിപ്പെ� ഡിയൂപ്ലിിയോക്കാറ്റി് എടുുത്തു് (ഇതിിനോ�ി വൃത്തും 

പ്പെൈലക്ട് പ്പെചായ്ത്് Edit → Duplicate (Ctrl+D) പ്പെൈലക്ട് 

പ്പെചായ്ത്ോൽ മാതിി) പകൂുതിി ഭ്യോഗിങ്ങിൾ പ്പെപോതിുവോ�ി 

വരിുന്നു തിരിത്തുിൽ യോചാർത്തുുവയ്ക്കാുകൂ.

 � രിണ്ടിോമാതി് നിർമ്മിിച്ച വൃത്തുത്തുിന് മാപ്പെറ്റിോരിു നിറാം നൽ

കൂുകൂ�ും അതിിപ്പെ� Opacity കൂുറായ്ക്കാുകൂ�ും പ്പെചായ്യാുകൂ. 

(Opacity കൂുറായ്ക്കാോൻ, കൂളിർപോലറ്റിിന് തിോപ്പെ��ോ�ി 

കൂോണംുന്നു Opacity �ോലകൂത്തുിൽ 100ൽ തിോപ്പെ��ുള്ള 

ഒരിു ൈംഖയ (ഉദിോ: 70) പ്പെകൂോടുുത്തുോൽ മാതിി - ചാിത്രിം 1.10).  

ഇ�യംുടെെ തണ്ടാ് വരയ്ക്കാംുന്നതിന്ി

 � Bezier Curve ടുൂൾ  പ്പെൈലക്ട് പ്പെചായ്ത്്, കൂോൻവോൈിൽ  വരിയ്ക്കാോൻ ഉയോ�ശിിക്കാുന്നു സ്ഥാലത്തു് ക്ലാിക്കാ് 

പ്പെചായ്യാുകൂ (അവിപ്പെടു ഒരിു ആങ്ക്ർ യോപോ�ി�് രിൂപം പ്പെകൂോള്ളുന്നുു).

 � മാ�ൈ് ചാലി�ിച്ച് വരി അവൈോനി�ിക്കാോൻ ഉയോ�ശിിക്കാുന്നുിടുത്തു്  ക്ലാിക്കാ് പ്പെചായ്ത്് എ�ർ അമാർ

ത്തുുകൂ (അവൈോന യോപോ�ി�ിൽ ഡിബാിൾ ക്ലാിക്കാ് പ്പെചായ്ത്ും Right Click പ്പെചായ്ത്ും വരി അവൈോനി

�ിക്കാം).

 � വരിപ്പെ� രിണ്ടിു വശിങ്ങിളിിയോലക്കാും വളിഞ്ഞിതിോക്കാോൻ, Edit path by nodes (N) ടുൂൾ എടുുത്തു് 

വരി�ുപ്പെടു വളിയ്ക്കാോനുയോ�ശിിക്കാുന്നു ഭ്യോഗിങ്ങിളിിൽ ക്ലാിക്കാ് പ്പെചായ്ത്ുപ്പെകൂോണ്ടി് വലിക്കാുകൂ (ചാിത്രിം 1.9).

ഇനി  Create circles, ellipses and arcs (E)  ടുൂളിുകൂൾ 

ഉപയോ�ോഗിിച്ച്, ഒലീവിലകൂൾ വരിച്ചുയോചാർക്കാം.

ഇനി ഒലീവില�ോണം്  യോവണ്ടിതി്.  Bezier Curve ടുൂൾ 

ഉപയോ�ോഗിിച്ചു നമാുക്കാിതി് വരിച്ചു യോചാർത്തുോയോലോ.

ചാിത്രിം 1.9 ൽ കൂോണംുന്നു രിീതിി�ിൽ ഇല�ുപ്പെടു തിണ്ടി് 

ആദിയം വരിച്ചുയോനോക്കാൂ.

ചിിത്രംം 1.9 Bezier Curve െൂള്‍  

ഉപ്ലോയംാഗംിച്ച് നിിര്‍മ്മിിച്ച ഒ�ീവി�ത്തണ്ടാ്
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ചിിത്രംം 1.11 Fill and Stroke ജാാ�ക്ം

ഇല�ുപ്പെടു വലു�വും ഓറാി�യോ�ഷംനും അനുയോ�ോ

�യമാോ� തിരിത്തുിൽ മാോറ്റിോൻ ശ്രദ്ധിിക്കാുമായോ�ോ. ഒലീവിപ്പെ� 

ചാി�യ്ക്കാും ഇലകൂൾക്കാും യോ�ോ�ിച്ച നിറാങ്ങിൾ പ്പെകൂോടുുക്കാോൻ 

മാറാക്കാരിുയോതി. (ചാിത്രിം 1.12)

രൂപ്ങ്ങള്‍ ഭംംഗംിയംാക്കാംാൻ

Fill and Stroke ഉപയോ�ോഗിിച്ച് രിൂപ 

ങ്ങിളിുപ്പെടു ഉള്ളിലും യോബാോർഡിറാിനും  

നിറാം പ്പെകൂോടുുക്കാം. വയതിയസ്ത തിരിത്തുി

ലുള്ള യോബാോർഡിറാുകൂൾ തിിരിപ്പെഞ്ഞിടുു

ക്കാോനും അവ�ുപ്പെടു കൂനം ക്രിമാീകൂരിി

ക്കാോനുമാുള്ള ൈ�കൂരിയം Stroke style 
�ോലകൂത്തുിലുണ്ടി്.  

അരിികൂുകൂപ്പെളി ല�ി�ിക്കാുന്നുതിിനും  

ഡിിസൈൈനുകൂളിിൽ നി�ലുകൂളിും ത്രിിമാോന 

ൈവഭ്യോവം പ്പെകൂോണ്ടിുവരിുന്നുതിിനും ഇയോതി 

�ോലകൂത്തുിലുള്ള blur ഉപയോ�ോഗിപ്പെ�ടുുത്തും. നിറാങ്ങിളിുപ്പെടു ൈുതിോരിയതി ക്രിമാീകൂരിിച്ച് രിൂപങ്ങിപ്പെളി  

ഭ്യോഗിികൂമാോയോ�ോ പൂർണ്ണമാോയോ�ോ ദൃശിയമാോക്കാോനുള്ളതിോണം് Opacity ക്രിമാീകൂരിണംം.

 � ഇയോ�ോൾ രിണ്ടിു വൃത്തുങ്ങിളിുപ്പെടു�ും പ്പെപോതിുവോ�ി 

വരിുന്നു ഭ്യോഗിം ഒരിു ഇല�ുപ്പെടു രിൂപത്തുിലോണംുള്ളതി്. 

പ്രസ്തുതി ഭ്യോഗിം മാോത്രിം നിലനിർത്തുോൻ, രിണ്ടിു വൃത്തു

ങ്ങിളിും ഒരിുമാിച്ച് പ്പെൈലക്ട്പ്പെചായ്ത്് Path പ്പെമാനുവിപ്പെല 

Intersection ക്ലാിക്കാ് പ്പെചായ്യാുകൂ.

 � ആവശിയോനുൈരിണംം ഇതിിപ്പെ� ഡിയൂപ്ലിിയോക്കാറ്റിുകൂൾ 

എടുുത്തു്, യോനരിയോത്തു വരിച്ച തിണ്ടിിൽ പല�ിടുത്തുോ�ി 

യോചാർത്തുുവയ്ക്കാുകൂ.

ചിിത്രംം 1.10 ഇ�ക്ള്‍ വരയ്ക്കാംുന്നതിടെ� ആദ്യ�ഘട്ടിം
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പ്രവർത്തുനം പൂർത്തുി�ോ�ിക്കാ�ിഞ്ഞിോൽ ഇലകൂളിും 

ചാി��ും ഒന്നുിച്ച് പ്പെൈലക്ട് പ്പെചായ്ത്് ഗ്രാൂ�് പ്പെചായ്യാം. ഗ്രാൂ�് 

പ്പെചായ്യാോൻ Ctrl+G അമാര്‍ത്തുി�ോല്‍ മാതിി. ചാി�പ്പെ� പ്രോവി

പ്പെ� പ്പെകൂോക്കാിൽ യോചാർത്തുുവയ്ക്കാുന്നുയോതിോപ്പെടു ഒലീവില�ു 

മാോ�ി പറാക്കാുന്നു പ്രോവിപ്പെ� ചാിത്രിം പൂർണ്ണമാോ�ി.

ചിിത്രംം ആക്ർഷക്മീാക്കാംാൻ  

ചിി� മീിനിുക്കാംുപ്ണിിക്ൾ  

ൈമാോധോനത്തുിപ്പെ� ഒലീവില�ുമാോ�ി ആകൂോശിയോത്തു

ക്കാു പറാക്കാുന്നു ഈ പ്രോവിപ്പെന നമ്മിുപ്പെടു യോപോസ്റ്റുറാിയോലക്കാ് 

ഉള്‍പ്പെ�ടുുത്തും. ഈ ചാിത്രിപ്പെത്തു കൂൂടുുതിൽ ആകൂർഷംകൂമാോ

ക്കാോന്‍  എപ്പെ��ം പ്പെചായ്യാോനോകൂും?

ഒരിു വൃത്തും വരിച്ച് ചാിത്രിത്തുിപ്പെ� പശ്ചാോത്തുലത്തുിൽ 

യോചാർത്തുുയോനോക്കാൂ.

ചിിത്രംത്തിനി് പ്ശ്ചാാത്ത�മീായംി വൃത്തം വരയ്ക്കാംുന്നതിനി് 

 � Create circles, ellipses and arcs (E) ടുൂൾ എടുുത്തു് ഒരിു പ്പെചാറാി� വൃത്തും വരിയ്ക്കാുകൂ. വൃത്തുത്തുിന് 

ചാുവന്നു നിറാം നല്‍കൂോം.

 � ഒലീവില�ുമാോ�ി പറാക്കാുന്നു പ്രോവിപ്പെന ഈ വൃത്തുത്തുിയോലക്കാു പ്പെകൂോണ്ടിുവരിുകൂ.

 � ഇയോ�ോൾ വൃത്തും മാുകൂളിിലും പ്രോവ് അടുി�ിലുമാോണംുള്ളതി്. പ്രോവിപ്പെന മാുകൂളിിയോലക്കാു പ്പെകൂോണ്ടിു 

വരിോന്‍ Pg Up, Pg Dn കൂീകൂൾ ഉപയോ�ോഗിിക്കാുകൂ.

 � പ്രോവിപ്പെന വരിച്ചിരിിക്കാുന്നു വരികൂളിുപ്പെടു നിറാം (Stroke Colour) മാോറ്റിുന്നുതിിനോ�ി (ഉദിോ: പ്പെവളിു�്)

ചാിത്രിം പ്പെൈലക്ട് പ്പെചായ്ത്് Shift കൂീ അമാർത്തുി�ിടുിച്ച് ആവശിയമാോ� നിറാത്തുിൽ ക്ലാിക്കാ് പ്പെചായ്യാുകൂ.

(ചാിത്രിം 1.13)

ചിിത്രംം 1.12 ഇങ്ക്്ലോ�പ്പംില്‍ വരച്ച ഒ�ീവ് ഇ�ക്ള്‍
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ചിിത്രംം 1.13 ചിിത്രംത്തിനി് പ്ശ്ചാാത്ത�ം ലോചിര്‍ത്തലോപ്പംാള്‍

നം നിർമ്മിിച്ച വൃത്തുത്തുിൽ, വലു�ം കൂുറാഞ്ഞി 

ഏതിോനും വൃത്തുങ്ങിൾ കൂൂട്ടിയോച്ചർത്തു് ഒരിു പോയോറ്റിൺ നിർ

മ്മിിച്ചുപ്പെകൂോണ്ടി് പശ്ചാോത്തുലവൃത്തുത്തുിൽ  കൂുറാച്ചുകൂൂടുി പ്പെമാച്ച

പ്പെ�ടുുത്തുലുകൂൾ ആ�ോയോലോ?

ആദിയം പ്രോവിപ്പെന വൃത്തുത്തുിൽനിന്നു് മാോറ്റിിവച്ച 

യോശിഷംം പശ്ചാോത്തുലവൃത്തുത്തുിൽ മാോറ്റിങ്ങിൾ വരിുത്തും.

ചാുവപ്പെടു നൽകൂി� പ്രവർത്തുനങ്ങിൾ പ്പെചായ്ത്ുയോനോക്കാൂ.

ഒന്നി�ധ്യാിക്ം വൃത്തങ്ങള്‍ ലോചിർത്തു  

പ്ാലോറ്റ്ൺ നിിർമ്മിിക്കാംം.

 � വൃത്തുത്തുിപ്പെ� ഒരിു Duplicate എടുുത്തു് അതിിപ്പെ� 

വലു�ം അല്‍�ം  കൂുറാച്ച് ആദിയ വൃത്തുത്തുിനുള്ളിൽ 

തിപ്പെന്നു ക്രിമാീകൂരിിക്കാുകൂ. (വലു� വയതിയോൈം വരിു

ത്തുുയോമ്പ്ോൾ വൃത്തുത്തുിപ്പെ� അനുപോതിത്തുിന് മാോറ്റിം 

വരിോപ്പെതി യോനോക്കായോണം).

 � പുതിി� വൃത്തുത്തുിന് നിലവിലുള്ള നിറായോത്തുക്കാോൾ 

അല്‍�ം കൂടുുംനിറാം പ്പെകൂോടുുക്കാം.

 � ഇത്തുരിത്തുിൽ വലു�ം കൂുറാഞ്ഞിുവരിുന്നു തിരിത്തുിൽ 

ഏതിോനും വൃത്തുങ്ങിൾകൂൂടുി വരിച്ച് കൂൂടുുതിൽ കൂടുും 

നിറാങ്ങിൾ ക്രിമാമാോ�ി പ്പെകൂോടുുത്തു് വൃത്തുത്തുിപ്പെ� മാധയത്തുി 

ലോ�ി വരിുന്നുവിധം ക്രിമാീകൂരിിക്കാുകൂ.

 � Object പ്പെമാനുവിപ്പെല Align and Distribute ഉപയോ�ോ 

ഗിിച്ച് ഒന്നുിലധികൂം രിൂപങ്ങിപ്പെളി ഉയോ�ശിിക്കാുന്നു  

തിരിത്തുിൽ അസൈലൻപ്പെമാ�് നടുത്തുി ക്രിമാീകൂരിിക്കാം 

(ചാിത്രിം 1.14).

ചിിത്രംം 1.14 Align & Distribute ജാാ�ക്ം

Align & Distribute
ഡിിസൈൈൻ ഘടുകൂങ്ങിപ്പെളി കൃതിയ 

മാോ�ി ക്രിമാീകൂരിിക്കാുന്നുതിിനുള്ള ഒരിു 

മാികൂച്ച ൈംവിധോനമാോണം് Align & 
Distribute.
ഒന്നുിലധികൂം വസ്തുക്കാപ്പെളി പരി�രിയോമാോ 

അപ്പെ�ങ്ക്ിൽ യോപ�ുമാോ�ി ബാന്ധപ്പെ�

യോട്ടോ ഉയോ�ശിിക്കാുന്നു തിരിത്തുിൽ വിനയ

ൈിക്കാോൻ ഇതി് ൈഹാോ�ിക്കാുന്നുു.

Shift+ Ctrl + A കൂീകൂൾ ഒരിുമാിച്ച് ഉപ

യോ�ോഗിിച്ച് ഈ �ോലകൂം തിുറാക്കാോ 

നോകൂും.

യോപ�ിപ്പെന ആ�ദിമാോക്കാിയോ�ോ 

ആദിയയോമാോ അവൈോനയോമാോ പ്പെൈലക്ട് 

പ്പെചായ്യാുന്നു വസ്തുക്കാപ്പെളി അടുിസ്ഥാോന

മാോക്കാിയോ�ോ അവപ്പെ� പരി�രിം ക്രിമാീ

കൂരിിക്കാോൻ കൂ�ി�ും.

ൈൂക്ഷ്മാതി ആവശിയമാുള്ള ഡിിസൈൈ

നുകൂൾക്കാ് വലി� ൈഹാോ�മാോണം് 

Align & Distribute ൈ�കൂരിയം.
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ചിിത്രംം 1.15 ഫ്ലിിപ്പം് ടെചിയ്ത ചിിത്രംം

ഒരിു യോപോസ്റ്റുറാിനോവശിയമാോ� പ്പെടുകൂ്സ്റ്റു്, ചാിത്രിങ്ങിൾ, 

മാറ്റി് ഡിിസൈൈൻഘടുകൂങ്ങിൾ എന്നുിവ തിയ്യാോറാോ�ിക്കാ�ി

ഞ്ഞിോൽ, അവ കൂോ�്ചായ്ക്കാ് ആകൂർഷംകൂവും ഫിലപ്രദിവുമാോ� 

യോലഔട്ടിൽ ക്രിമാീകൂരിിക്കാുകൂ എന്നുതിോണം് അവൈോനവട്ട  

മാിനുക്കാുപണംി.

നമ്മിുപ്പെടു യോപോസ്റ്റുറാിപ്പെ� പശ്ചാോത്തുലമാോ�ി വരിുന്നു ചാതിു

രിത്തുിനു മാുകൂളിിൽ ചാിത്രിവും പ്പെടുകൂ്സ്റ്റുും അനുയോ�ോ�യമാോ� 

വൃത്തുങ്ങിൾ ഏകൂയോകൂന്ദ്രമാോ�ി ക്രിമാീകൂരിിച്ചിരിിക്കാുന്നു 

തിിന് Align and Distribute പ്പെല ഏതി് മാോർഗിമാോണം് ഉപയോ�ോ

ഗിിച്ചിരിിക്കാുന്നുപ്പെതിന്നു്  കൂപ്പെണ്ടിത്തുുമായോ�ോ.

പുതിി� പശ്ചാോത്തുലമാോ�ി വൃത്തുങ്ങിളിുപ്പെടു പോയോറ്റിണ്‍ 

തിയ്യാോറാോ�യോ�ോ. ഇനി, വൃത്തുത്തുിന് ഏറ്റിവും മാുകൂളിിൽ ഒലീ

വില�ുമാോ�ി പറാക്കാുന്നു പ്രോവിപ്പെ� ചാിത്രിം വീണ്ടിും യോചാർത്തുു

വച്ചുയോനോക്കാൂ. എപ്പെ�ങ്ക്ിലും അപോകൂം യോതിോന്നുുന്നുുയോണ്ടിോ?

പ്രോവും ഒലീവില�ും വൃത്തുത്തുിന് അടുി�ിലോ�ി 

യോ�ോ�ി, അയോ�?

 � ഏതി് കൂീ ഉപയോ�ോഗിിച്ചോലോണം് പ്രോവിപ്പെന ഏറ്റിവും മാുകൂ

ളിിയോലക്കാ് പ്പെകൂോണ്ടിുവരിോൻ കൂ�ി�ുകൂ?

 � ചാിത്രിം 1.15യോലതിുയോപോപ്പെല ഈ പ്രോവിപ്പെന വലയോത്തുോട്ട് 

തിിരിിഞ്ഞിതിോക്കാോൻ എ�ു പ്പെചായ്യാണംം? കൂോൻവോൈിന്  

മാുകൂളിിലുള്ള Tool Controls barൽ ഇതിിനുള്ള ൈ�കൂരിയ 

മാുയോണ്ടിോ എന്നു് പരിിയോശിോധിക്കാൂ.

 � പ്രോവിപ്പെ� വോ�്ഭ്യോഗിം വൃത്തുത്തുിന് അല്‍�ം പുറായോത്തുക്കാ് 

നില്‍ക്കാുന്നു തിരിത്തുിലോ�ോയോലോ?

ഡിിജാിറ്റ്ല്‍ ലോപ്ാസ്റ്റര്‍

ഗ്രാോഫിികൂ് ഡിിസൈൈനിങ്് യോൈോ

ഫി് റ്റി് പ്പെവ�ർ ഉപയോ�ോഗിിച്ച് നിർമ്മിി

ക്കാുന്നു ഒരിു ആശി�വിനിമാ� ഉപോ

ധി�ോണം് ഡിി�ിറ്റിൽ യോപോസ്റ്റുറാുകൂൾ. 

ആശി�ം വയക്തമാോക്കാുന്നു വോക്കാു

കൂൾ, വരികൂൾ, ചാിത്രിങ്ങിൾ എന്നുീ 

ഡിിസൈൈൻഘടുകൂങ്ങിൾ ഇതിിൽ 

ഉൾപ്പെ�ടുുന്നുു.

യോൈോഷംയൽ മാീഡിി� പ്ലിോറ്റി് യോഫിോമാു

കൂളിിലൂപ്പെടു ആശി�ങ്ങിൾ പങ്ക്ിടുുന്നു

തിിന് ഇവ ഏപ്പെറാ ൈഹാോ�കൂമാോണം്. 

ൈോധോരിണം യോപോസ്റ്റുറാുകൂളിിൽനിന്നു് 

ഡിി�ിറ്റിൽ യോപോസ്റ്റുറാുകൂൾ വയതിയസ്ത

മാോകൂുന്നുതി് അവ�ുപ്പെടു സൈവവിധയം, 

നിരി�രിം പ്പെമാച്ചപ്പെ�ടുുത്തുോനും വയോ

പകൂമാോ�ി പ്രചാരിി�ിക്കാോനുമാുള്ള 

ൈോധയതി എന്നുിവപ്പെകൂോണ്ടിോണം്.
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ചിിത്രംം 1.16 പ്ൂര്‍ത്തിയംായം യംുദ്ധവിരുദ്ധ ലോപ്ാസ്റ്റര്‍

സ്ഥാോനങ്ങിളിിൽ ക്രിമാീകൂരിിക്കാുകൂ. യോപോസ്റ്റുറാിപ്പെല എ�ോ  

ഡിിസൈൈൻഘടുകൂങ്ങിളിും തിമ്മിിലുള്ള ൈ�ുലിതിോവസ്ഥാ 

നിലനിർത്തുണംം.  

വയതിയസ്ത അഭ്യിരിുചാികൂളിുള്ള കൂോ�്ചാക്കാോരിോ�ി ൈവ�ം 

കൂരിുതിി യോപോസ്റ്റുറാിപ്പെന വീണ്ടിും ൈമാീപിക്കാുയോമ്പ്ോൾ, ഈ 

ഘട്ടത്തുിലും ചാില പ്പെമാച്ചപ്പെ�ടുുത്തുലുകൂൾ ൈവോഭ്യോവികൂമാോ�ും 

ഉണ്ടിോകൂോൻ ൈോധയതി�ുണ്ടി്.  അവരിവരിുപ്പെടു ഭ്യോവനയ്ക്കാനുൈ

രിിച്ച് ആവശിയമാോ� കൂൂട്ടിയോച്ചർക്കാലുകൂളിും പ്പെമാച്ചപ്പെ�ടുുത്തുലു

കൂളിും നടുത്തുി യോപോസ്റ്റുറാിപ്പെന കൂൂടുുതിൽ ആകൂർഷംകൂമാോക്കാോൻ 

ശ്രമാിക്കാൂ. (ചാിത്രിം 1.16)

ലോപ്ാസ്റ്റർ ക്ാന്‍വാൈിനിു പ്ുറലോത്തക്കാം്  

ഹാിയോരിോഷംിമാദിിനോചാരിണംത്തുിപ്പെ� പ്രചാോരിണംത്തുിനോ

�ുള്ള �ുദ്ധിവിരിുദ്ധി യോപോസ്റ്റുർ പൂർത്തുി�ോ�യോ�ോ. ഫി�ൽ 

വീണ്ടിും യോൈവ് പ്പെചായ്യാുമായോ�ോ.

യോപോസ്റ്റുർ കൂോൻവോൈിൽനിന്നു് പുറായോത്തുക്കാ് എടുു

യോക്കായോണ്ടി? യോൈോഷംയൽമാീഡിി� വ�ി പ്രചാരിി�ിക്കാോനുള്ള 

ൈ�കൂരിയത്തുിനോ�ി ചാിത്രിപ്പെത്തു നമാുക്കാ് PNG യോഫിോർമാോറ്റിി

യോലക്കാു മാോറ്റിം.

ഇങ്ക്്ലോ�പ്പംിടെ�  

എക് ് ൈ് ലോപ്ാര്‍ട്ടിിങ്്

ഇങ്ക്്യോസ്കൂപ് ഉല്‍�ന്നുങ്ങിപ്പെളി PNG, 
JPEG, WEBP എന്നുിങ്ങിപ്പെന വയതിയസ്ത 

യോഫിോർമാോറ്റിുകൂളിിയോലക്കാ്  Export 
പ്പെചായ്യാോൻ  ൈോധിക്കാും. പ്പെവബാ്, 

പ്രി�് യോപ്രോ�കൂ് ടുുകൂള്‍ക്കാ് യോ�ോ�ിച്ച 

തിരിത്തുിലുള്ള പ്പെറാൈലയൂഷംൻ, ഫി�ൽ 

വലു�ം, യോഫിോർമാോറ്റി് എന്നുിവ 

തിിരിപ്പെഞ്ഞിടുുക്കാോന്‍ ശ്രദ്ധിിക്കാണംം. 

സ്ക്രീീൻ/പ്പെവബാ് ഡിിൈ് യോപ്ലി ആപ്പെണംങ്ക്ിൽ 

96dpi പ്പെറാൈലയൂഷംൻ മാതിി�ോകൂും. 

എന്നുോൽ പ്രി�് ആവശിയത്തുിന് ഇതി് 

300dpi ആകൂുന്നുതിോണം് ന�തി്.
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പോ�ോസ്റ്റർ തയ്യാോറാോയിിക്കഴിിഞ്ഞപോ�ോപോഴിക്കം� എല്ലാോ

വരുംം� മിികച്ച ഡിിസൈൈനർമിോരുംോയിി മിോറാി അപോല്ലാ. ഇനി 

ഇങ്ക്്പോ��് ഉ�പോയിോഗിിച്ച്  മിറ്റൊ�ോരുംം പോ�ോസ്റ്റർ ൈവന്തമിോയിി 

തയ്യാോറാോക്കംമിപോല്ലാോ.

Inkscape ൽനിിന്ന്് ഫയൽ PNG ആയി Export ചെ�യ്യാാൻ

 � പോ�ോസ്റ്ററാിറ്റൊ� എല്ലാോ ഘടകങ്ങറ്റൊ�യിം� ഒന്നിിച്ച് റ്റൊൈ�ക്ട്് റ്റൊ�യ്ത്് ഗ്രൂൂ�് റ്റൊ�യ്യാംക.

 � File → Export PNG Image എന്നി ക്രമിത്തിിറ്റൊ�ടംക്കംക. (�ിത്രം� 1.17)

 � വ�തംഭാോഗിത്തി് തംറാന്നിംവരുംംന്നി ജാോ�കത്തിിൽ Export area എന്നിതിൽ Selection തിരുംറ്റൊഞ്ഞടം

ക്കംക. (ഒരുംം പോ�ജാ് �ൂർണ്ണമിോപോയിോ അതിറ്റൊ� റ്റൊൈ�ക്ട്് റ്റൊ�യ്ത് ഭാോഗിങ്ങൾ മിോത്രംമിോപോയിോ ഇവിറ്റൊട  

എക്ൈ് പോ�ോർട്ട്് റ്റൊ�യ്യാോനോകം�).

 � Resolution ൽ ആവശ്യയമിോയി മിോ�ങ്ങൾ വരുംംത്തിംക.

 � ഫയി�ിനം പോ�രുംംറ്റൊകോടംത്തി്, പോൈവ് റ്റൊ�പോയ്യാണ്ട പോഫോൾ ഡിർ തിരുംറ്റൊഞ്ഞടംക്കംക.

 � പോശ്യഷം� Export റ്റൊ�യ്യാംക.

�ിത്രംം 1.17 ഇങ്ക്്സ്കേ�പ്് - എക‍്‍ ് സ്‍് സ്കേപ്ാര്‍ട്ട്് ജാാലക‍്‍ം

നിങ്ങൾ തയ്യാോറാോക്കിയി പോ�ോസ്റ്റർ Export PNG 
Image ൈപോങ്ക്ത� ഉ�പോയിോഗിിച്ച് PNG പോഫോർമിോ�ിപോ�ക്ക്  

എക ്ൈ് പോ�ോര്‍ട്ട്് റ്റൊ�യ്യാൂ.
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നിിഴു�ും ടെവളുിച്ചവും

ത്രിിമാോനൈവഭ്യോവമാുള്ള രിൂപങ്ങിൾ ഇങ്ക്്യോസ്കൂപ് ഉപയോ�ോഗിിച്ച് എളിു�ത്തുിൽ വരിയ്ക്കാോൻ 

കൂ�ി�ും. ഒരിു വസ്തുവിൽ പ്പെവളിിച്ചം വീ�ുയോമ്പ്ോൾ ഉണ്ടിോകൂുന്നു തിിളിക്കാവും അവിപ്പെടു രിൂപ 

പ്പെ�ടുുന്നു നി�ലും അനുഭ്യവപ്പെ�ടുുത്തുുന്നു തിരിത്തുിലുള്ള യോഷംഡിിങ്് ഉപയോ�ോഗിിച്ചോണം് ഇതി്  

പ്പെചായ്യാുന്നുതി്. ഇങ്ക്്യോസ്കൂ�ിപ്പെല Gradient ടുൂളിും Blur ൈയോങ്ക്തിവും ഇതിിനോ�ി ഉപയോ�ോഗിപ്പെ�ടുുത്തും. 

ഇവ ഉപയോ�ോഗിിച്ച് ഒരിു പ�് വരിയ്ക്കാുന്നുപ്പെതിങ്ങിപ്പെനപ്പെ�ന്നു് യോനോക്കാം.

 � ഇങ്ക്്യോസ്കൂ�ിപ്പെല Create circle and ellipses, arcs (E) ടുൂൾ എടുുത്തു് ഒരിു വൃത്തും വരിയ്ക്കാുകൂ  

(പൂർണ്ണവൃത്തുമാോകൂുന്നുതിിന് Ctrl കൂീ അമാർത്തുി�ിടുിക്കാണംം).

 � വൃത്തുത്തുിന് കൂടുുംനിറാം പ്പെകൂോടുുക്കാം (ഉദിോ: കൂടുും നീല).

 � വൃത്തുത്തുിനു മാുകൂളിിൽ അതിിപ്പെ� ഒരിു പകൂർ�് എടുുത്തു് വയ്ക്കാുകൂ (Ctrl+D).

 � Create and edit Gradients (G) ടുൂൾ പ്പെൈലക്ട് പ്പെചായ്ത്തിിനുയോശിഷംം Tools Controls bar ൽനിന്നു് 

Radial Gradient പ്പെൈലക്ട് പ്പെചായ്ത്് മാുകൂളിിപ്പെല വൃത്തുത്തുിൽ ക്ലാിക്കാ് പ്പെചായ്ത്് �ോഗി് പ്പെചായ്യാുകൂ (ഇയോ�ോൾ 

വൃത്തുത്തുിൽ Gradient Handles പ്രതിയക്ഷമാോവുന്നുു).

 � യോനര്‍യോരിഖ�ിലുള്ള രിൂപങ്ങിളിോപ്പെണംങ്ക്ില്‍ Linear Gradient ആണം് ഉപയോ�ോഗിിയോക്കാണ്ടിതി്.

 � തിുടുർന്നു്, Edit paths by Nodes (N) ടുൂൾ ഉപയോ�ോഗിിച്ച് Gradient Handles പ്പെ�  മാധയഭ്യോഗിത്തു് ക്ലാിക്കാ് 

പ്പെചായ്ത്് ഇളിംനിറാവും (ഉദിോ: ഇളിംനീല) അറ്റിങ്ങിളിിൽ ക്ലാിക്കാ് പ്പെചായ്ത്് കൂടുുംനിറാവും പ്പെകൂോടുുക്കാുകൂ. 

 � Gradient Handles ആവശിയോനുൈരിണംം തിിരിിച്ചും നീട്ടി�ും സ്ഥാോനം മാോറ്റിി�ും പ്പെവളിിച്ചം വീ�ു

യോമ്പ്ോൾ ഉണ്ടിോകൂുന്നു തിിളിക്കാവും എതിിർഭ്യോഗിപ്പെത്തു ഇരിുട്ടിപ്പെ� ആ�വും ക്രിമാീകൂരിിക്കാുകൂ.

പ�ിപ്പെ� നി�ൽ യോചാർക്കാുന്നുതിിന് ഇതിിന് തിോപ്പെ� ഒരിു ദിീർഘവൃത്തും വരിച്ച് അതിിപ്പെ� സ്ഥാോനവും 

വലു�വും കൃതിയമാോക്കാുകൂ. ഇതിിന് കൂറാു�ുനിറാം പ്പെകൂോടുുത്തു് Fill and Stroke �ോലകൂത്തുിൽ 

നിന്നു് Blur ഉം Opacity �ും ആവശിയോനുൈരിണംം ക്രിമാീകൂരിിക്കാുകൂ. Pg Dn  കൂീ ഉപയോ�ോഗിിച്ച്, നി�ൽ 

പ�ിന് തിോപ്പെ��ോ�ി ക്രിമാീകൂരിിക്കാം.

വി�യംിരുത്തം

  യോനോഡിുകൂളിും കൂർവുകൂളിും എഡിിറ്റി്പ്പെചാ�് തി് ഇഷ്ടോനുസൃതി രിൂപങ്ങിൾ സൃഷം് ടുിക്കാോൻ ഇങ്ക്്യോസ്കൂ�ിൽ 

ഏതി് ടുൂൾ ആണം് ഉപയോ�ോഗിിയോക്കാണ്ടിതി്?

 a) Rectangle Tool    b)  Circle Tool
 c) Pencil Tool    d)  Bezier Tool
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

തുെര്‍പ്രാവര്‍ത്തനിങ്ങള്‍

1. ഇങ്ക്്യോസ്കൂപ് ഉപയോ�ോഗിിച്ച് ഇതിുയോപോലുള്ള കൂൂടുുതിൽ ൈ്സൈമാലികൂൾ തിയ്യാോറാോക്കാുകൂ.

2. ചാുവപ്പെടു നൽകൂി� രിൂപം ഇങ്ക്്യോസ്കൂ�ിൽ വരിയ്ക്കാുകൂ. ൈിലിണ്ടിറാിപ്പെ� പുറാംഭ്യോഗിം ഡിിസൈൈൻ പ്പെചായ്യാു

ന്നുതിിന് Linear gradient ആണം് ഉപയോ�ോഗിിയോക്കാണ്ടിതി്.

3. സ്കൂൂളിിപ്പെല അധയോപകൂരിും കൂുട്ടികൂളിും യോചാർന്നു് തിയ്യാോറാോക്കാി� ഒരിു യോഷംോർട്ട് ഫിിലിമാിപ്പെ�  

പ്രകൂോശിന ചാടുങ്ങിിൽ യോസ്റ്റു�ിപ്പെ� പിറാകൂിൽ സ്ഥാോപിക്കാുന്നുതിിനോ�ി 6'x3' വലു�ത്തുിലുള്ള ഒരിു 

ബാോനർ യോവണംം. ഈ ബാോനറാിപ്പെ� ഡിിസൈൈൻ ഇങ്ക്്യോസ്കൂ�ിൽ തിയ്യാോറാോക്കാി PNG ഫി�ലോക്കാി 

എകൂ ്ൈ് യോപോര്‍ട്ട് പ്പെചായ്യാുകൂ.

4. വിദിയോരിംഗിം കൂലോൈോഹാിതിയയോവദിി പ്രൈിദ്ധിീകൂരിിക്കാോനുയോ�ശിിക്കാുന്നു മാോഗിൈിന് ഒരിു കൂവർയോപ�് 

തിയ്യാോറാോക്കാുകൂ.

5. ലിറ്റിിൽ സൈകൂറ്റി്ൈ് �ി�ോതില ൈഹാവോൈ കൂയോമ്പ്് ഈ വർഷംം നിങ്ങിളിുപ്പെടു സ്കൂൂളിിൽവച്ചോണം്  

ൈംഘടുി�ിക്കാുന്നുതി് എന്നു് കൂരിുതിുകൂ. കൂയോമ്പ്ിൽ പപ്പെങ്ക്ടുുക്കാുന്നു കൂുട്ടികൂൾക്കാോ�ി ഒരിു ബാോഡി്�് 

ഇങ്ക്്യോസ്കൂ�ിൽ രിൂപകൂല്‍�ന പ്പെചായ്യാുകൂ.

 ഇങ്ക്്യോസ്കൂ�ിൽ രിണ്ടി് രിൂപങ്ങിള്‍ യോചാർത്തുുവച്ച് പ്പെൈലക്ട് പ്പെചായ്ത്് "Path → Difference" എന്നു പ്രവർ

ത്തുനം പ്പെചായ്യാുയോമ്പ്ോൾ എ�ോണം് ൈംഭ്യവിക്കാുകൂ?

a) രിണ്ടി് രിൂപങ്ങിളിും യോചാർന്നു്, ഒന്നുോ�ി മാോറാുന്നുു.

b) തിോപ്പെ��ുള്ള രിൂപത്തുിൽനിന്നുു രിണ്ടിു രിൂപവും യോചാർന്നുുനിൽക്കാുന്നു ഭ്യോഗിം ഒ�ിവോകൂുന്നുു.     

c) രിണ്ടിു രിൂപങ്ങിളിുപ്പെടു�ും പകൂർ�ുകൂള്‍ ഉണ്ടിോവുന്നുു.  

d) രിണ്ടിു രിൂപങ്ങിളിും രിണ്ടിു ഭ്യോഗിങ്ങിളിോ�ി മാോറാുന്നുു. 

 ഇങ്ക്്യോസ്കൂ�ിൽ ഒരിു ഒബാ്�ക്ടിപ്പെ� Transparency 0% ആക്കാി�ോൽ എ�ോണം് ൈംഭ്യവിക്കാുകൂ?

a) ഒബാ്�ക്ട്ൈുതിോരിയമാോ�ി, കൂോണംോൻ ൈോധിക്കാോപ്പെതി�ോവുന്നുു.

b) ഒബാ്�ക്ട് പ്പെവളിുത്തു നിറാമാോകൂുന്നുു.     

c) ഒബാ് �ക്ടിന് കൂറാുത്തുനിറാമാോകൂുന്നുു.  

d) ഒബാ്�ക്ട് കൂോൻവോൈിൽനിന്നു് ഒ�ിവോക്കാപ്പെ�ടുുന്നുു.
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